
 Dreamweaver Primer 

Continuing Studies CS 38  Page 1 of 28 

DDrreeaammwweeaavveerr  PPrriimmeerr  
Using Dreamweaver CS3 to Create 

and Publish Simple Web Pages 
  
 

Continuing Studies CS 38:  
Using Dreamweawver, Photoshop, and Fireworks –  

Graphics Production for the Web 
  

January 2010 

 



 Dreamweaver Primer 

Continuing Studies CS 38  Page 2 of 28 

Contents 
 

Dreamweaver Primer .................................................................................................. 1 

Booklet Goal and Objectives .................................................................................... 3 

Configuring Dreamweaver ........................................................................................ 4 

A Quick Overview of HTML ....................................................................................... 8 

Modifying Layout ........................................................................................................ 10 

Formatting Text .......................................................................................................... 12 

Breaking Lines and Paragraphs ........................................................................ 12 

Creating Headings .................................................................................................. 13 

Bolding and Italicizing Text ................................................................................ 13 

Fonts and Web Pages ............................................................................................... 14 

Making Lists .................................................................................................................. 15 

Uniform Resource Locator (URL) ......................................................................... 16 

Making Links ................................................................................................................. 17 

Images ............................................................................................................................ 19 

Internal Links ............................................................................................................... 22 

Special Text Characters in HTML ......................................................................... 23 

Getting Your Pages Noticed .................................................................................... 24 

Listing Web Pages with a Search Tool ........................................................... 24 

Using Meta Tags ..................................................................................................... 24 

Publishing Web Pages ............................................................................................... 26 

Maintaining Your Web Site After You Leave This Class ............................... 27 

Resources ...................................................................................................................... 28 

 



 Dreamweaver Primer 

Continuing Studies CS 38  Page 3 of 28 

Booklet Goal and Objectives 

The goal of this booklet is to teach you the basics of using Adobe 
Dreamweaver CS3. 

 

The objectives of this course include your being able to: 

• Understand basic HTML (HyperText Markup Language). 

• Create a simple web page using Dreamweaver. 

• “Publish” a web page, by uploading it to the Tripod web server. 
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Configuring Dreamweaver 

Dreamweaver is a web site management tool designed to simplify the 
creation and maintenance of web sites.  With Dreamweaver, anyone 
can create and edit web pages with ease – Dreamweaver writes the 
HTML code for you.   Dreamweaver is not designed for single web page 
creation; rather, it is designed for creating and maintaining a complete 
web site.  Therefore, Dreamweaver needs to know where all of the 
local content (copies of the web pages and images) of your particular 
web site resides. 

To configure Dreamweaver: 

1. On the Site menu, click New Site. 

. 

 

2. In the What is the HTTP Address for your site field, enter the 
name of your site.   This name will never appear on any web 
pages; it is only for Dreamweaver.   
In the What is the HTTP Address for your site, field, enter 
http://YOUR-TRIPOD-USERNAME.tripod.com/  

3. Click Next. 
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4. Although we will not be using it in this class, you will be offered 
the option of using Server Technology (ColdFusion, asp.net, asp, 
jsp, php).  Click Next. 

5. Enter the location of the web page files on your computer.  (In 
class, they will be on the folder with your name on the Desktop).  
You will publish them (copy them to a web server) from this 
location.  Click Next. 
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6. To publish to the Tripod servers, enter or select the following: 

a) In the Sharing Files section, select FTP. 

b) In the What is the hostname or FTP address of your 
Web server? field, enter ftp.tripod.com 

c) In the What folder on the server do you want to store 
your files in field, leave it blank. 

d) In the What is your FTP login field, enter your Tripod 
Username. 

e) In the What is your FTP password field, enter your 
Tripod username's password. 

f) Make sure the Use Secure FTP (SFTP) box is left 
unchecked.  

g) Click Next. 

  

a)   

b)   

c)   

d)  

e)   

f)   

g)  
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7. Since we will not be collaborating with anyone else on this web 
site, click No, do not enable check in and check out, and 
then click Next. 

 

8. Review the Site Definition Summary to ensure that all of your 
settings are correct.  Then, click Done. 
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A Quick Overview of HTML  

Dreamweaver is a great web editor, and a wonderful time saver for 
creating web pages, since it converts your mouse clicks and 
keyboarding into clear, clean HTML code.   However, to troubleshoot 
problems with your web site, you will still need to understand what 
Dreamweaver is actually writing. 

We normally think of a web page as the fully formatted, graphics-laden 
document that is displayed when a browser opens to a particular web 
address.  Here, for example, is the main Stanford web page 
(http://www.stanford.edu): 

 

It turns out, however, that the web page isn’t actually this document 
with pictures and color and neatly formatted text.  This is merely the 
processed version of the web page.  The actual web page is a plain 
text source code file, which the browser translates into the fully 
formatted web page.  The pictures, colors, and other non-text items 
on a web page aren’t actually on the web page itself — the web page 
itself is simply text, with the formatting and graphics encoded.  You 
can look at the code for any web page on most web browsers by 
clicking the View menu and then clicking Source or Page Source.  
The source code file is written in a language known as the HyperText 
Markup Language, or HTML.  

Here’s an example of a processed web page and its source code: 
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One of HTML’s strengths is its platform independence.  The web pages 
produced using HTML can be viewed on many different types of 
computers using any web browser. 

Most HTML tags work in pairs — a starting tag that tells the web 
browser to begin using the effect, and an ending tag that tells the 
browser to stop it.   

Tags are always enclosed in angle brackets:  <tag>  

The ending tag of a pair of tags always features a forward-leaning 
slash just after the first angle bracket:  </tag> 

For example, to create a boldfacing effect, the bold tag, <strong>, can 
be used.  To make the words “this class is great” appear bold, the 
code is 

<strong> this class is great </strong> 

In this example, the <strong> tells the browser to start the boldfacing 
effect, and the </strong> tells the browser to end the boldfacing effect. 

Attributes can be added to a tag to modify its effect.   They always 
appear as part of the starting tag: 

<tag attribute="value"> text text text </tag> 

For example, to center text, use the paragraph tag , <p>, and modify 
it with the attribute align and value center: 

<p align="center"> text text text </p> 

Although earlier versions of HTML allowed designers to use either 
uppercase or lowercase, the latest version, xHTML, requires that tags 
and attributes be typed in all lowercase characters. 

A few tags are “singles” that mark the spot where, for example, a 
graphic or line break or horizontal rule-line should go.  Single tags 
must end with a space followed by the forward slash: <tag /> 

For example, to display a horizontal line across the page, use the 
horizontal rule tag:  <hr /> 

Dreamweaver automatically converts your mouse clicks and 
keyboarding into the HTML code for your web page. 
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Modifying Layout 

Dreamweaver allows you to make global changes to the layout of a 
web page — changes such as font, color, and header structure.  You 
may also set up a  
“style sheet” of features to apply to an entire web site, multiple web 
pages (to be discussed in a more advanced class).  This is known as 
Cascading Style Sheets. 

To set the layout appearance choices for an entire web page in 
Dreamweaver: 

1. On the Modify menu, click Page Properties. 

 

2. In the Appearance category, set up the defaults for your web 
page (font name, font size, font color, margins, etc.). 

 

3. In the Links category, set up the colors and style for the links 
on your web page. 
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4. In the Headings category, choose the appearance for each 
heading level. 

 

5. In the Title/Encoding category, ensure that the title of your 
web page accurately reflects the content of your web page.  The 
title of a web page is the part of the web page that is saved as a 
favorite when the page is bookmarked.  It is also the text that 
search engines (e.g., Google) use to help determine ranking.  
Make sure your title is an accurate reflection of your page and 
contains those words you wish associated with your web site. 

 

6. In the Tracing Image category, leave the options set to their 
defaults.  This category lets you insert an image file for use as a 
guide in designing your page.  For more information about using 
Tracing Image, see Dreamweaver’s help feature (click Help). 

7. Click OK to set your page properties. 
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Formatting Text 

Breaking Lines and Paragraphs 
There are two tags used to create line breaks: 

1. The paragraph tag pair, <p> </p>.  This pair surrounds a 
paragraph, one or more lines of text.  Most browsers process this 
in such a way that a blank line appears between paragraphs. 

<p> text text text </p> 

In Dreamweaver, paragraph tag pairs are created when the 
Enter key is pressed. 

   

2. The line break tag, <br />.  This single tag is used whenever a 
carriage return effect is desired (when you want to break a line, 
but do not necessarily wish a blank line to follow).  It can be 
used within a <p> tag pair, if necessary.  Note that since the line 
break tag is a single tag, it requires a space followed by a slash 
at the end. 

 text text text <br /> 

In Dreameaver, this effect is created by holding down the Shift 
key while pressing Enter. 
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Creating Headings 
The headings tag pairs <h1> </h1> through <h6> </h6> enclose text 
that will appear as a heading of a section of a web page.  Most web 
browsers will boldface and enlarge a heading and set it on its own, 
separate line.   In Dreamweaver, this is done by highlighting the text, 
then selecting the appropriate heading level from the Properties 
palette. 

        

 

Bolding and Italicizing Text 
There are several tags used to change how text appears on a web 
page.  The tag pair <strong> </strong> is used to make the text bold 
(the B button on the Properties palette).  The tag pair <em> </em> is 
used to make text appear in italics (the I button on the Properties 
palette). 

 



 Dreamweaver Primer 

Continuing Studies CS 38  Page 14 of 28 

Fonts and Web Pages 
In Dreamweaver, the font’s name (typeface), size, and color can be 
easily modified.  Use these modifications with care: 

• Color used poorly can make the page unreadable.   

• Beware of a dark background with dark text.  Or a light 
background with light text – try to keep high contrast between 
the background and text.   

• When changing colors, remember that colored text often 
indicates links.  Seeing too many colored, non-link words on a 
page can be confusing to the viewer. 

Also, use caution when specifying a particular font.   If the viewer’s 
computer does not have the font, the desired effect will not be 
produced.   Specifying a generic alternative—serif, sans-serif, and 
monospace—is the safest option, since these are readable by virtually 
all browsers and computers. 

To change the font name, font color, or font size in Dreamweaver, first 
highlight the text you want to change, and then make your choices in 
the Properties palette. 

 

 

 

 

 

 

 

 

Font Name 

Font Color 

Font Size 
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Making Lists 

You can easily add formatted lists to your pages. 

Unordered Lists are created using the <ul> </ul> tag pair.  These tags 
go at the very beginning and end of the list.  In addition, each item in 
the list is surrounded by a list item tag pair, <li> </li>.  The list item 
tag pair tells the browser to put that item on its own line.  Most 
browsers process the unordered list item tag with a bullet. 

 

Ordered Lists are created using the <ol> </ol> tag pair.  Just like the 
<ul> tag pair, these go at the beginning and end of a list.  Again, each 
separate item in the list is surrounded by a list item tag pair, <li> </li>.  
In an ordered list, browsers process the list item tag pair with a 
number, thereby creating a numbered list. 

 

In Dreamweaver, press the  button to begin an unordered list and 
the  button to begin an ordered list.  The List Item tags are 
automatically generated. 
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Uniform Resource Locator (URL) 

The URL (Uniform Resource Locator), also known as a web address, 
describes the location of a web page on the Internet.  The first part of 
a URL is the protocol, which tells the browser how the information is to 
be sent and received.   

Some typical protocols are:   

• http://   for web pages on the Internet 

• https://  for secured web pages on the Internet 

• file:///  for files on a local desktop computer 

• mailto:email@domain.com   for email addresses 

 

The next part of a URL lists the name of the computer that houses the 
web page.  This computer is called a server.   

After the server, the URL lists the path, or directory structure, needed 
to get to the web page.   

The last part of the URL lists the file name.  If no file name is listed, 
the browser will assume the web page’s name is index.html. 

For example, the in URL shown below, the protocol is http://, the 
server computer is www.stanford.edu, the path is 
/people/johndoe/, and the file name is resume.html.  In other 
words, the browser will be instructed to use the http protocol to go on 
the Internet, locate the www.stanford.edu computer, go down the 
/people/johndoe/ pathway, and display the file resume.html. 
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Making Links 

To create a hypertext link in Dreamweaver, highlight the text that will 
be clicked on, then enter the URL in the Link section of the Properties 
palette: 

 

This causes a pair of tags known as “anchors” to be used, making 
clickable, “hot” links from the web page to some other place on the 
Internet.  By surrounding a piece of text in the source code with an 
anchor tag pair, the text appears as a clickable link when the web 
page is viewed in a browser.  When the viewer’s mouse hovers over 
the link, the mouse pointer changes from an arrow to a hand.  When 
the mouse is clicked, another location on the Internet is displayed. 

This “other location” is determined by its URL.   The tag for anchor is 
<a>, the attribute used is href, which stands for Hypertext REFerence, 
and the value of href is the URL of the link.  

<a href="URL-of-other-location"> text to become a clickable link </a> 

Here is an example: 

<a href="http://www.stanford.edu"> Click here to visit Stanford. </a> 

 

 
  

Warning!   
Be sure to have the correct spelling and punctuation of the URL.   

Also, case counts!  
For example, http://www.stanford.edu/people/johndoe/ is not the same 
as http://www.stanford.edu/people/JohnDoe/ or 
http://www.stanford.edu/people/JOHNDOE/. 
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Fully Qualified vs. Relative URLs 
Anchor tag pairs can be fully qualified or relative URLs. 

Fully qualified URLs completely define the protocol, the domain of the 
server computer which houses the web page, the path, and the file 
name.   

Relative URLs may omit the protocol, domain, or path.  The browser 
will assume the current protocol, domain, or path are to be used.  By 
current, we mean the domain and directory of the page that is 
currently being displayed (i.e., relative to the current page, display 
this page). 

Relative URLs only work when the web page being linked to sits on the 
same web server as the page containing the link.  For example, to 
make a clickable link to a page stored as foo.html on the same server 
and in the same folder as the current page, one would use the 
following anchor tag: 

<a href="foo.html"> clickable link text </a> 

Note that the protocol, domain, and path have been omitted.  The 
browser will assume that they are the same as those of the referring 
document page. 

If foo.html were to stay on the same server but move to a different 
folder, called blotz, a relative URL could still be used, as long as the 
folder and path were included. 

<a href="/blotz/foo.html"> clickable link text </a> 

If you are in doubt as to how to make a relative URL, use the fully 
qualified URL instead.  The fully qualified URL defines exactly where an 
object is on the Internet. 
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Images 

In word processing, when you place an image (e.g., a picture or a 
chart) in a document, that image becomes an embedded part of the 
document file, like nuts in a brownie.  This is why these documents 
can become quite large. 

The web scheme does not work this way.  Instead, images that appear 
on a web page are stored on a web server as separate files, and the 
source code for the web page — which is always a plain-text file — 
contains tags that point to the location of the images.  Whenever that 
web page is loaded, the browser must fetch each of the image files 
separately and display them on the web page according to the HTML. 

The tag used to display images is the image tag <img>.  Because the 
<img> tag is a single tag, it must end with a space and a forward slash. 

Here’s an example: 

<img src="http://www.stanford.edu/gifs/stanford17-quad-zoom.gif" /> 

The image tag is inserted in the source text at the point where the 
image should appear when the web page is viewed.  Although the 
image file must be stored on a web server somewhere on the Internet, 
it does not necessarily need to be stored on the same web server as 
the source code file (web page). 

To add an image to a web page using Dreamweaver, on the Insert 
menu, click Image, locate the image file, and press OK. 
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PNG, JPEG, and GIF File Formats 

Of the dozens of graphics file formats that computers are capable of 
creating and storing, only three can be displayed on a web page by 
web browsers:   

• PNG (Portable Network Graphic)  

• JPG (Joint Photographic experts Group)  

• GIF (Graphics Interchange File)  

If you plan to create your own images or to scan in photographs to be 
used on the web, be sure the image files are either the PNG, JPG, or 
GIF format. 

 

Using Images From Online Sources 

There are many free archives for images available on the web.  Keep 
in mind, however, that images, as well as text, are considered 
copyrighted materials and should not be used without permission.   If 
you see an image you like that isn’t clearly labeled as being available 
for your use, seek permission before you use it. 

It is best to store a copy of the image you plan to use in your own web 
folder (on the server).  In addition, you should save a copy on your 
local computer, in the folder in which you are creating your web pages.   

There are two reasons for putting a copy of the image in your web 
folder on the server.  First, if you point to the image on the remote 
server, each time someone views your page, it will load slowly, 
because the web browser will need to make a separate connection to 
that remote server to pull that image in and display it on your page.  
Second, there’s always the chance that the provider of the image will 
stop providing it (or change its location), leaving you without access to 
the image for your page. 

A great repository of freely usable media files, including images, is the 
Wikimedia Commons:  http://commons.wikimedia.org/ 
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To copy an image to your web space:  

1. Open your browser and locate the image’s web page. 

2. Place your mouse over the image. 

3. Windows users: Right-click the mouse.   
Mac users: Control-click the mouse button until the dialog box 
appears. 

4. Select Save Picture As (or Save Image As or Download 
Image to Disk or Save Graphic As, depending on your 
browser). 

5. Save the image to your hard drive in the folder in which you are 
creating your web pages. 
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Internal Links 

Internal links point viewers to a specific spot in a web page. You can 
point to a place in the current document or to a specific spot in 
another document.   

First, you need to decide the spot (target) you’ll be pointing people to.  
In Dreamweaver, first place the cursor at that target point.   Then, on 
the Insert menu, click Named Anchor. The named anchor can called 
be anything you want.  Using one word is best, however (e.g., 
PageTop, not Page Top).   

   

To point users to this target, highlight the text that will serve as the 
hyperlink, and click and drag the Point to File  to the Named 

Anchor . 
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Special Text Characters in HTML 

Sometimes, you need to add non-keyboard characters – such as ©, ñ, 
or Ç –  
to a web page.  HTML requires the use of standard keyboard (ASCII) 
characters, which does not include these special characters.  
Fortunately, there is a set of codes (some text and some numeric) 
which allow us to specify many useful non-keyboard characters.  

To use special characters in Dreamweaver, on the Insert menu, point 
to HTML, then to Special Characters, and then click the desired 
character.  If the character you wish to insert is not among the 
commonly used characters, click Other to locate it.  
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Getting Your Pages Noticed 

Once you have created your web site, you will want people to know 
about it.  Depending on the content and the intended audience, you 
may want to list it with a search tool, like Yahoo or Google.  In that 
case, there are some things you can do to maximize the chances of 
being listed by search tools. 

Listing Web Pages with a Search Tool 

Almost all search tools have a way for you to add your page to their 
site.   Decide which search tools you want your page listed with, and 
sign up.  Some services will let you sign up for several tools at once 
(usually for a fee).  Check the home pages of specific search engines 
for instructions on signing up for these services. 

Using Meta Tags 

Another way search tools find your page is through the use of web 
crawlers.  Web crawlers are software programs that go from a known 
page and follow the links on it.  They then add all these pages to the 
search tool’s database.  In this way, a search tool can find more and 
more pages—making its search results more useful to users. 

Meta tags are a way for you, the web page creator, to specify 
keywords and descriptions for your pages.  As the search engines do 
searches in their indexes, they use meta tags as one way to determine 
the order in which documents are listed on the results pages.  Meta 
tags are an important way to make your search tool listings more 
effective.  The meta tag looks like this: 

<meta name="text" content="text" /> 

There are several options for the meta tag attributes: 

<meta name="keywords" content="list, of, keywords, separated, by, commas" /> 
<meta name="description" content="a brief text description of your web page" /> 
<meta name="robots" content="noindex" /> 
 
The last one tells a search tool NOT to list your page on its site.  You 
can do this if you do not want the general public to find the page.  Be 
aware that this last tag may be ignored by search tools and should not 
be used when security is important.  There are other, better security 
options available (e.g., password protection). 
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To add meta tags using Dreamweaver, on the Insert menu, point to 
Head Tags, and then click the meta tag desired (Keywords or 
Description). 
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Publishing Web Pages 

By moving a copy of your web page from your desktop computer to 
the web server, you will “publish” your web page, and anyone, 
anywhere in the world who has Internet access, will be able to view 
your web page.  Publishing on the Internet simply involves copying a 
web page into the “right” folder on a web server.  On Tripod, this 
folder is the main, root folder that is associated with your Tripod 
username.    

Once you publish your web page on the Tripod server, the URL for the 
page is based on your Tripod username: 

http://YOUR-TRIPOD-USERNAME.tripod.com/ 

Publishing Using Dreamweaver 
Publishing a web page using Dreamweaver is a simple, 3-step process, 
assuming that everything has been configured correctly.   

1. Check that you are in the web page you wish to publish. 

2. On the Site menu, click Put. 

3. Click Yes when Dreamweaver asks if you wish to put the 
dependent files (dependent files include any CSS, JavaScript, or 
image files associated with your web page). 

 

Dreamweaver will connect and publish your web page. 
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Maintaining Your Web Site After You 
Leave This Class 

Right now, your web site only exists in 2 places: on the classroom 
computer, and on the Tripod server.  When you return home, or to 
your office, you will want to configure the copy of Dreamweaver on 
your own computer to enable you to continue to work on the web site 
you developed in class. 

To work on your web site at your computer: 

1. Launch Dreamweaver. 

2. Configure Dreamweaver (see Configuring Dreamweaver, p. 4). 
 
In the Editing Files section of the Site Definition window, at 
the Where on your computer do you want to store your 
files? question, click the folder icon  and locate a folder on 
your hard drive in which to store the files associated with your 
web site. 
 
If you wish to create a new folder to store the files, click the 
Create New Folder icon. 

 Windows:   
 

 Macintosh:  

3. Click the connect button to connect to your Tripod account: 

 

4. Download (copy) your files from the server computer to the 
folder you designated/created on your computer in the previous 
step. 

5. Return to Dreamweaver and begin updating the web site.  
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Resources 

• The Adobe Dreamweaver web site contains documentation and 
other support. 
http://www.adobe.com/software/dreamweaver/ 

• Dreamweaver Exchange contains commands, helper-programs, 
and other downloads to increase the efficiency and capabilities of 
Dreamweaver. 
http://www.adobe.com/cfusion/exchange/  

• Barry’s Clipart Server is a free image repository. 
http://www.barrysclipart.com/ 

• The Wikimedia Commons is a database of millions of freely usable 
media files. 
http://commons.wikimedia.org/ 

• Primarily for Stanford users, the Stanford Web Guide is a starting 
point for information about building and maintaining web sites for 
Stanford offices and departments, containing style guidelines, 
design elements, best practices, page templates, and more. 
http://webguide.stanford.edu 

• Information about the Stanford University Web Services can be 
found at: 
http://web.stanford.edu 

• Stanford’s Web Services Wiki is a source for developer resources 
and a place to collaborate on standards and best practices. 
http://web.stanford.edu/wiki 

• Stanford’s Techcommons is an online hub that brings together 
dispersed resources and technology groups on campus. 
http://techcommons.stanford.edu/ 

• For information on web accessibility, go to the The Stanford 
Online Accessibility Program (SOAP) web site: 
http://soap.stanford.edu/ 

 


